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Warranty
The PXI-8461 is warranted against defects in materials and workmanship for a period of one year from the da
shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or re
equipment that proves to be defective during the warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evid
by receipts or other documentation. National Instruments will, at its option, repair or replace software media that 
execute programming instructions if National Instruments receives notice of such defects during the warranty pe
National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outs
of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping
of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully re
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the 
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader 
consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any dam
arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL  INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS 
ANY WARRANTY OF MERCHANTABILITY  OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’ S RIGHT TO RECOVER DAMAGES CAUSED 
BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL  INSTRUMENTS SHALL BE LIMITED  TO THE AMOUNT THERETOFORE PAID BY THE 
CUSTOMER. NATIONAL  INSTRUMENTS WILL  NOT BE LIABLE  FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, 
OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of 
National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence.
Any action against National Instruments must be brought within one year after the cause of action accrues. Natio
Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The wa
provided herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to 
the National Instruments installation, operation, or maintenance instructions; owner’s modification of the product;
owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third partie
or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mecha
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, wit
the prior written consent of National Instruments Corporation.

Trademarks
BridgeVIEW™, CVI™, LabVIEW™, natinst.com™, and NI-CAN™ are trademarks of National Instruments Corporation

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS
National Instruments products are not designed with components and testing intended to ensure a level of reliab
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving m
or clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the part
user or application designer. Any use or application of National Instruments products for or involving medical or cl
treatment must be performed by properly trained and qualified medical personnel, and all traditional medical safeg
equipment, and procedures that are appropriate in the particular situation to prevent serious injury or death should
continue to be used when National Instruments products are being used. National Instruments products are NOT i
to be a substitute for any form of established process, procedure, or equipment used to monitor or safeguard huma
and safety in medical or clinical treatment.



 
  FCC/DOC Radio Frequency Interference 

Class A Compliance

This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance 
with the instructions in this manual, may cause interference to radio and television reception. Classification 
requirements are the same for the Federal Communications Commission (FCC) and the Canadian 
Department of Communications (DOC). This equipment has been tested and found to comply with the 
following two regulatory agencies:

Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant 
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user will be required to correct the 
interference at his own expense.

Notices to User: Changes or modifications not expressly approved by National Instruments could void 
the user’s authority to operate the equipment under the FCC Rules.

If necessary, consult National Instruments or an experienced radio/television technician for additional 
suggestions. The following booklet prepared by the FCC may also be helpful: Interference to Home 
Electronic Entertainment Equipment Handbook. This booklet is available from the U.S. Government 
Printing Office, Washington, DC 20402.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations.
Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur 
du Canada.
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This manual contains instructions to help you install and configure you
PXI-8461 (one port and two port) and the NI-CAN software for 
Windows 95/98. This manual uses PXI-8461 to refer to both the one p
and two port versions of the PXI-8461.

This manual assumes that you are already familiar with Windows 95/9

How to Use the Manual Set

Use this getting started manual to install and configure your PXI-8461 
the NI-CAN software for Windows 95/98.

Use the NI-CAN User Manual to learn the basics of CAN and how to 
develop an application program. The user manual also contains detail
examples.

NI-CAN
User Manual

for Windows 95
and Windows NT

Application
Development
and Examples

First-Time
NI-CAN Users

Experienced
NI-CAN Users

NI-CAN Programmer
Reference Manual

for Win32

Function
and Object

Descriptions

Getting Started
Manual

Installation and
Configuration
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Use the NI-CAN Programmer Reference Manual for specific information 
about each NI-CAN function and object, including format, parameters, 
possible errors.

Organization of This Manual
This manual is organized as follows:

• Chapter 1, Introduction, explains how to use this manual, lists what 
you need to get started, provides an overview of the PXI-8461 (on
port and two port) and the NI-CAN software for Windows 95/98, an
describes optional equipment you can order.

• Chapter 2, Installation and Configuration, describes how to install and
configure the NI-CAN software for Windows 95/98 and the PXI-846
hardware.

• Chapter 3, Verify the Installation, describes how to verify the hardware
and software installation.

• Chapter 4, Begin to Use the NI-CAN Software, helps you get started 
with the NI-CAN software for Windows 95/98.

• Appendix A, Uninstalling the Hardware and Software, describes how 
to uninstall the PXI-8461 hardware and the NI-CAN software from
Windows 95/98.

• Appendix B, Cabling Requirements, describes the cabling 
requirements for the hardware.

• Appendix C, Troubleshooting and Common Questions, describes how 
to troubleshoot problems and answers some common questions.

• Appendix D, Specifications, describes the physical characteristics o
the hardware and the recommended operating conditions.

• Appendix E, Customer Communication, contains forms you can use to
request help from National Instruments or to comment on our produ
and manuals.

• The Glossary contains an alphabetical list and a description of term
used in this manual, including abbreviations, acronyms, metric 
prefixes, mnemonics, and symbols.
PXI-8461 and NI-CAN for Windows 95/98 x © National Instruments Corporation
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Conventions Used in This Manual
The following conventions are used in this manual:

» The » symbol leads you through nested menu items and dialog box opt
to a final action. The sequence File»Page Setup»Options»Substitute 
Fonts directs you to open the File menu, select the Page Setup item, 
selectOptions, and finally select the Substitute Fonts option from the last 
dialog box.

This icon to the left of bold italicized text denotes a caution, which advi
you of precautions to take to avoid injury, data loss, or a system crash

bold Bold text denotes the names of menus, menu items, dialog boxes, dia
box buttons or options, icons, windows, Windows 95/98 tabs, or LEDs

bold italic Bold italic text denotes a caution.

italic Italic text denotes emphasis, a cross reference, or an introduction to a
concept.

monospace Text in this font denotes text or characters that you should literally ent
from the keyboard, sections of code, programming examples, and syn
examples. This font is also used for the proper names of disk drives, pa
directories, programs, subprograms, subroutines, device names, funct
parameters, operations, variables, filenames, and extensions, and for 
statements and comments taken from program code.

paths Paths in this manual are denoted using backslashes (\) to separate d
names, directories, folders, and files.

Related Documentation
The following documents contain information that you may find helpful 
you read this manual.

• ANSI/ISO Standard 11898-1993, Road Vehicles—Interchange of 
Digital Information—Controller Area Network (CAN) for High-Spee
Communication

• CAN Specification Version 2.0, 1991, Robert Bosch Gmbh., 
Postfach 500, D-7000 Stuttgart 1

• CiA Draft Standard 102, Version 2.0, CAN Physical Layer for 
Industrial Applications

!

© National Instruments Corporation xi PXI-8461 and NI-CAN for Windows 95/98



About This Manual

 
ur 
e it 
tion 
• CompactPCI Specification, Revision 2.0, PCI Industrial Computers 
Manufacturer’s Group.

• DeviceNet Specification, Version 2.0, Open DeviceNet Vendor 
Association

• Microsoft Windows 95/98 User’s Guide, Microsoft Corporation

• PXI Specification, Revision 1.0, National Instruments Corporation

Customer Communication
National Instruments wants to receive your comments on our products
and manuals. We are interested in the applications you develop with o
products, and we want to help if you have problems with them. To mak
easy for you to contact us, this manual contains comment and configura
forms for you to complete. These forms are in Appendix E, Customer 
Communication, at the end of this manual. 
PXI-8461 and NI-CAN for Windows 95/98 xii © National Instruments Corporation
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Introduction

This chapter explains how to use this manual, lists what you need to g
started, provides an overview of the PXI-8461 (one port or two port) a
the NI-CAN software for Windows 95/98, and describes optional 
equipment you can order.

How to Use This Manual

Yes

No

Chapter 3

Chapter 4

User Manual and
Programmer Reference

Manual
Write Application Program

Passes?

Gather What You Need
to Get Started

Chapter 1

Install the Hardware

Install the Software

Verify the Installation

Review Programming
Considerations

Troubleshooting
Appendix

Configure the Software

Chapter 2
r Windows 95/98
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What You Need to Get Started
Make sure you have all of the following items before you attempt to ins
the hardware and software:

❑ Windows 95 or Windows 98 installed on your computer

❑ One of the following boards, which is included in your kit:

PXI-8461 one port
PXI-8461 two port

❑ The following 3.5 in., high-density (1.44 MB) disks, which are 
included in your kit:

NI-CAN Software for Windows 95/98 and Windows NT (Disk 1 of 2
NI-CAN Software for Windows 95/98 and Windows NT (Disk 2 of

❑ CAN interface cables that meet the requirements in Appendix B, 
Cabling Requirements

Hardware Overview
The PXI-8461 (one port and two port) is software configurable 
and compliant with the PXI Specification and CompactPCI Specification. 
With a PXI-8461 board, you can make your PXI or CompactPCI chass
communicate with and control CAN devices.

The PXI-8461 physical layer fully conforms to the ISO 11898 physical
layer specification for CAN and is optically isolated to 500 V. CAN 
interfacing is accomplished using the Intel 82527 CAN controller chip. T
PXI-8461 supports a wide variety of transfer rates up to 1 Mb/s. The C
physical layer on the PXI-8461 can be powered either internally (from 
board) or externally (from the bus cable power). The power source for
CAN physical layer for each port is configured with a jumper. 

PXI-8461 boards are available with two physical connector types: 

• DB-9 D-Sub

• Combicon-style pluggable screw terminals

The PXI-8461 uses the Intel 386EX embedded processor to implemen
time-critical features provided by the NI-CAN software. The PXI-8461 
communicates with the NI-CAN driver through on-board shared memo
and an interrupt.
PXI-8461 and NI-CAN for Windows 95/98 1-2 © National Instruments Corporation
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NI-CAN Software Overview
The NI-CAN software includes a native, 32-bit multitasking Windows 
driver that is fully Plug and Play aware. The driver components are 
dynamically loaded when Windows detects new hardware and dynamic
unloaded when Windows detects the removal of hardware.

The NI-CAN software is fully integrated into the Windows operating 
system. You can configure it through the Windows Device Manager an
uninstall it through the Add/Remove Programs applet of the Control Pa

The NI-CAN software supports the concurrent use of multiple CAN 
boards. For example, you can use both a PXI-8461 and a PCMCIA-CA
in the same system at the same time. 

The NI-CAN software, along with the PXI-8461, transforms your 
computer into a CAN interface with complete communications and bus
management capability. The NI-CAN software includes the following 
components:

• Firmware (runs on embedded Intel 386EX)

• Device driver

• Diagnostic test utility

• Configuration utility

• Language interface libraries for Microsoft Visual C/C++ 2.0 or late
LabWindows/CVI 4.0 or later, and LabVIEW 4.0 or later

• Example programs that use NI-CAN functions

Optional Programming Tools
Your kit includes the NI-CAN software for Windows 95/98. In addition,
you can order the LabWindows/CVI, LabVIEW, or BridgeVIEW softwar
from National Instruments.

LabWindows/CVI is an interactive ANSI C development environment f
building test and measurement and instrument control systems. It inclu
interactive code-generation tools and a graphical editor for building cus
user interfaces. It also includes built-in libraries for IEEE 488.2, VXI, 
RS-232 control, and plug-in data acquisition. When you order 
LabWindows/CVI, you also get hundreds of complete instrument drive
which are modular, source-code programs that handle the communica
© National Instruments Corporation 1-3 PXI-8461 and NI-CAN for Windows 95/98
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with your instrument so that you do not have to learn the programming
details.

LabVIEW is a complete programming environment that departs from t
sequential nature of traditional programming languages and features a
graphical programming environment. It includes all the tools needed fo
instrument control, data acquisition, analysis, and presentation. LabVI
also includes an extensive instrument driver library.

BridgeVIEW is a radical departure from traditional automation softwar
that provides a flexible program development system for a variety of 
DeviceNet applications including general manufacturing, test, and cont
Leveraging National Instruments patented graphical programming 
language G (otherwise known as LabVIEW), BridgeVIEW gives you th
ability to integrate functionality in a way that is not possible with tradition
automation software. In addition to the programming advantages of G
BridgeVIEW also provides a number of powerful features for the 
development of your industrial automation application: graphical HMI 
(Human Machine Interface); ease of use; fill-in-the-blank configuration
utilities; HMI G Wizard for simplified HMI development; historical data 
collection and trending; alarm and event reporting and logging; securit
and connectivity to PLCs and industrial device networks like DeviceNe

For more information about LabWindows/CVI, LabVIEW, and 
BridgeVIEW, contact National Instruments.
PXI-8461 and NI-CAN for Windows 95/98 1-4 © National Instruments Corporation
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Installation and Configuration

This chapter describes how to install and configure the NI-CAN softwa
for Windows 95/98 and the PXI-8461 hardware.

Install the NI-CAN Software
Install the NI-CAN software before you install your hardware.

1. Select Start»Settings»Control Panel.

2. Double-click on the Add/Remove Programs icon in the Control Panel 
to launch the Add/Remove Programs applet. A dialog box similar 
the one in Figure 2-1 appears.

Figure 2-1.  Add/Remove Programs Properties Dialog Box
r Windows 95/98
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3. Click on the Install  button.

4. When prompted, insert the NI-CAN Software for Windows 95/98 and
Windows NT (Disk 1 of 2), and click on the Next button to proceed. 
The software installation wizard begins with the screen shown in 
Figure 2-2.

Figure 2-2.  NI-CAN Software Setup Screen

The setup wizard guides you through the necessary steps to insta
NI-CAN software. You may go back and change values where 
appropriate by clicking on the Back button. If at any time you want to 
exit the setup, click on the Cancel button.

5. Shut down Windows 95/98 and turn off your computer when you 
complete the setup.

6. Proceed to the next section, Install the Hardware.
PXI-8461 and NI-CAN for Windows 95/98 2-2 © National Instruments Corporation
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Install the Hardware
This section describes how to install your PXI-8461 hardware.

Install Your PXI-8461

Caution Before you remove the board from the package, touch the antistatic plastic 
package to a metal part of your system chassis to discharge electrostatic ener
which can damage several components on your board.

1. Make sure that your PXI or CompactPCI chassis is turned off. Ke
the PXI or CompactPCI chassis plugged in so that it remains 
grounded while you install the PXI-8461.

2. Choose an unused PXI or CompactPCI 5 V peripheral slot.

3. Remove the filler panel for the peripheral slot you have chosen

4. Touch a metal part on your chassis to discharge any static 
electricity that might be on your clothes or body.

5. If you plan to use your PXI-8461 in a system where bus power 
available, you may want to configure the power supply jumpers 
your board. See Appendix B, Cabling Requirements, for more 
information.

6. Insert the PXI-8461 into the selected 5 V slot. Use the 
injector/ejector handle to fully inject the device into place. 
Figure 2-3 shows how to install the PXI-8461 into a PXI or 
CompactPCI chassis.

!
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Figure 2-3.  Installing the PXI-8461

7. Screw the front panel of the PXI-8461 to the front panel mounting r
of the PXI or CompactPCI chassis.

8. Turn on your PXI or CompactPCI chassis and start Windows 95/
Windows 95/98 should automatically detect the hardware and 
associate it with the NI-CAN software. A New Hardware Found 
dialog box appears, then goes away on its own. If the dialog bo
does not go away, select Windows default driver and click on the 
OK  button.

If the New Hardware Found dialog box does not appear when you
restart Windows 95/98, refer to the section Device Manager Problems 
in Appendix C, Troubleshooting and Common Questions.

When you have finished installing the hardware, proceed to the next 
section, Connect the Cables.

1 Injector/Ejector Handle (In Down Position)
2 PXI-8461 Board

3 PXI Chassis
4 Injector/Ejector Rail

8

7

6

5

4

3

2

1

ON

STANDBY

4

1

2

3
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Connect the Cables
After you have installed your board, connect the CAN cables to your 
PXI-8461. Because exact cabling requirements vary for each applicati
National Instruments does not provide cables. Refer to Appendix B, 
Cabling Requirements, for information about the cabling requirements o
the hardware.

The PXI-8461 installation is complete. Proceed to the next section, 
Configure the NI-CAN Software.

Configure the NI-CAN Software
The NI-CAN Configuration utility is fully integrated with the Windows 
Device Manager. You can use it to examine or modify the configuration
the NI-CAN software. The context-sensitive online help, available by 
right-clicking on any of the controls on the configuration utility buttons,
includes all the information you need to configure the NI-CAN softwar

To configure the NI-CAN software, double-click on the System icon under 
Start»Settings»Control Panel. In the System Properties dialog box that 
appears, select the Device Manager tab, click on the View devices by type 
radio button at the top of the tab, and double-click on the National 
Instruments CAN Interfaces icon. 

If there is no National Instruments CAN Interfaces item or if a circled X 
or exclamation point (!) appears through the eagle icon, the CAN interfa
is not working properly. Figure 2-4 shows an example of a PXI-8461 
that is working properly, and Figure 2-5 shows an example of a PXI-8461 
that is not working properly. Refer to the Device Manager Problems 
section of Appendix C, Troubleshooting and Common Questions, to 
resolve the problem.

Figure 2-4.  Device Manager Shows PXI-8461 That Is Working Properly
© National Instruments Corporation 2-5 PXI-8461 and NI-CAN for Windows 95/98
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Figure 2-5.  Device Manager Shows PXI-8461 That Is Not Working Properly

To configure a particular interface, double-click on that interface in the 
of installed interfaces below National Instruments CAN Interfaces.

The Resources tab provides information about the hardware resources
assigned to the CAN interface. Use the Resources tab to examine the 
assigned resources to verify that there are no conflicts. The Conflicting 
Device List lists any conflicts. If conflicts exist, uncheck the Use 
automatic settings checkbox and use the Change Setting button to select 
conflict-free resources for the CAN hardware.

The Settings tab, shown in Figure 2-6, provides information about the 
NI-CAN software configuration for the CAN interface. 

Figure 2-6.  Settings Tab for the PXI-8461
PXI-8461 and NI-CAN for Windows 95/98 2-6 © National Instruments Corporation
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Each port of the PXI-8461 is configured from the same tab. Use the 
drop-down box nearest the top of the tab to select the physical port num
to configure. For each port, use the Name drop-down box to select the name
for the CAN Network Interface Object (CAN0, CAN1, and so on). You use 
this name to refer to the physical port from within your NI-CAN 
application.

To access online help for the NI-CAN Configuration utility, right-click 
the mouse anywhere on the Settings tab, and select Full Help  from 
the pop-up menu that appears. You can also select What’s This? from the 
pop-up menu to see context-sensitive help for the item you have clicke

When you have finished configuring the NI-CAN software, proceed to 
Chapter 3, Verify the Installation.
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Verify the Installation

This chapter describes how to verify the hardware and software 
installation.

You can use the NI-CAN Diagnostic utility, installed with your NI-CAN 
software, to test the hardware and software installation. The utility verif
that your hardware and software are functioning properly and that the 
configuration of your hardware does not conflict with anything else in yo
system.

To run the utility, select the NI-CAN Diagnostic item under 
Start»Programs»NI-CAN Software.

When you have started the NI-CAN Diagnostic utility, test your CAN 
interfaces by clicking on the Test All button. You can also test one CAN 
interface by highlighting it and clicking on the Test One button. If the 
NI-CAN Diagnostic is successful, it puts a checkmark next to the interfa
and changes its status from Untested to Passed. If the NI-CAN Diagnostic 
fails, it puts an X next to the interface, and changes its status from Untested 
to Failed. Figure 3-1 shows the NI-CAN Diagnostic utility after it has 
tested some CAN interfaces.

Figure 3-1.  NI-CAN Diagnostic Utility after Testing
r Windows 95/98
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You can get details about any tested CAN interface by selecting the 
interface and clicking the Details button. For each failed CAN interface, 
select it and click the Details button to get a description of the failure. 
Use that information and the information in Appendix C, Troubleshooting 
and Common Questions, to troubleshoot the problem. Troubleshooting 
information is also available in the online help for the NI-CAN Diagnost
utility, which you can access by clicking on the Help button.
PXI-8461 and NI-CAN for Windows 95/98 3-2 © National Instruments Corporation
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Begin to Use the NI-CAN 
Software

This chapter helps you get started with the NI-CAN software for 
Windows 95/98.

Using the NI-CAN Software
The functions provided by the NI-CAN software are similar to those 
provided by many other device drivers. For example, NI-CAN has ope
close, read, and write functions. NI-CAN provides two different levels 
access to a CAN network: the CAN Network Interface Object and CAN
Objects. Both forms of access support timestamping of incoming data
various forms of queuing.

The CAN Network Interface Object provides low-level access to a CAN
network. Each CAN Network Interface Object maps to a specific CAN
port, with no limitation on the maximum number of ports or boards you c
use (for example, two PXI-8461 two-port interfaces would provide CAN0 
through CAN3). You can use this object to transmit and receive entire CA
frames. For example, to transmit a CAN frame, you would specify the 
outgoing arbitration ID, frame type (data or remote), data length, and d

The CAN Objects provide higher level access to a CAN network. Each
CAN Object maps to a specific data item (arbitration ID), and you can 
multiple CAN Objects for a given port. When configuring a CAN Objec
for use, you specify the arbitration ID, direction of data transfer, data 
length, and how you want the data to be accessed (such as periodically
example, you could configure a CAN Object to transmit an outgoing d
frame for a specific arbitration ID every 100 ms. After opening this CA
Object, you use the write function to provide data to transmit, and the 
NI-CAN embedded firmware handles all periodic timing. 

For detailed information on the NI-CAN software and functions, refer t
the NI-CAN User Manual and the NI-CAN Programmer Reference 
Manual.
r Windows 95/98
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General Programming Considerations
As you begin developing your Win32 NI-CAN application, remember th
following points:

• For your LabVIEW or BridgeVIEW application, you must use the 
NI-CAN LabVIEW functions in nican.llb . 

• For your C/C++ application, you must include the NI-CAN header fi
nican.h , in your source code. 

• The NI-CAN software is accessed through the 32-bit DLL, 
nican.dll , either by linking with one of the language interfaces 
provided with the NI-CAN software, or by using direct DLL entry 
from other programming environments.

• Several sample CAN applications are included with the NI-CAN 
software. Use them as a guide for your own application developm

For information about developing your application, refer to the NI-CAN
User Manual. For detailed information about NI-CAN functions and 
objects, refer to the NI-CAN Programmer Reference Manual.
PXI-8461 and NI-CAN for Windows 95/98 4-2 © National Instruments Corporation
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Uninstalling the Hardware 
and Software

This appendix describes how to uninstall the PXI-8461 hardware and 
NI-CAN software from Windows 95/98.

Uninstalling the Hardware from Windows 95/98
Before physically removing the board from the computer, you must rem
the hardware information from the Windows Device Manager.

To remove the hardware information from Windows 95/98, complete th
following steps:

1. Select Start»Settings»Control Panel. 

2. Double-click on the System icon.

3. In the System Properties dialog box that appears, select the 
Device Manager tab.

4. Click on the View devices by type button at the top of the Device 
Manager tab.

5. Double-click on the National Instruments CAN Interfaces icon.

6. To remove a board, select it from the list of boards under National 
Instruments CAN Interfaces as shown in Figure A-1 and click on the
Remove button. 
r Windows 95/98
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Figure A-1.  Selecting an Interface to Remove from Windows 95/98

After you remove the appropriate hardware information from the Devic
Manager, you should shut down Windows, power off your PXI or 
CompactPCI chassis, remove any cables attached to your board, and
physically remove the board from your computer.
PXI-8461 and NI-CAN for Windows 95/98 A-2 © National Instruments Corporation
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Uninstalling the NI-CAN Software from Windows 95/98
Before uninstalling the NI-CAN software, you should remove all PXI-84
boards from your computer, as explained in the previous section.

Complete the following steps to remove the NI-CAN software:

1. Select the Add/Remove Programs icon under Start»Settings» 
Control Panel. A dialog box similar to the one in Figure A-2 appear
This dialog box lists the software available for removal.

Figure A-2.  Add/Remove Programs Properties Dialog Box

2. Select the NI-CAN software you want to remove and click on the 
Add/Remove button. The uninstall program runs and removes all 
folders, utilities, device drivers, DLLs, and registry entries associa
with the NI-CAN software. Figure A-3 shows the results of a 
successful uninstallation.
© National Instruments Corporation A-3 PXI-8461 and NI-CAN for Windows 95/98
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Figure A-3.  NI-CAN Uninstallation Results

The uninstall program removes only items that the installation program
installed. If you add anything to a directory that was created by the 
installation program, the uninstall program does not delete that directo
because the directory is not empty after the uninstallation. You must 
remove any remaining components yourself.

If you want to reinstall the hardware and software, refer to Chapter 2, 
Installation and Configuration.
PXI-8461 and NI-CAN for Windows 95/98 A-4 © National Instruments Corporation
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Cabling Requirements

This appendix describes the cabling requirements for the hardware. 

Cables should be constructed to meet these requirements and the 
requirements of the other CAN or DeviceNet devices in the network.

Connector Pinouts
Depending on the type of PXI-8461 you are installing, it has either DB
D-Sub connectors(s) or Combicon-style pluggable screw terminal 
connector(s).

The 9-pin D-Sub follows the pinout recommended by CiA Draft 
Standard 102. Figure B-1 shows the pinout for this connector.

Figure B-1.  Pinout for 9-Pin D-Sub Connector

The 5-pin Combicon-style pluggable screw terminal follows the pinout
required by the DeviceNet Specification. Figure B-2 shows the pinout for 
this connector. 

1
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3
4
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6
7

8
9

No Connection

CAN_L

V–

No Connection

Optional Ground (V–)

CAN_H

No Connection

V+
Shield
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Figure B-2.  Pinout for 5-Pin Combicon-Style Pluggable Screw Terminal

CAN_H and CAN_L are signal lines that carry the data on the CAN 
network. These signals should be connected using twisted-pair cable.

The V+ and V– pins are used to supply bus power to the CAN physical 
layer if external power is required for the CAN physical layer. If internal 
power for the CAN physical layer is used, the V– pin serves as the reference
ground for CAN_H and CAN_L. See the next section, Power Supply 
Information for the CAN Ports, for more information.

Power Supply Information for the CAN Ports
For the PXI-8461, a jumper controls the source of power for the CAN 
physical layer. For the PXI-8461 one-port and port one of the PXI-8461
two-port, power is configured with jumper J5. For port two of the PXI-8461 
two-port, power is configured with jumper J6. The location of these 
jumpers is shown in FigureB-3.
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Figure B-3.  PXI-8461 Power Source Jumpers

Connecting pins 1 and 2 of a jumper configures the CAN physical laye
be powered externally (from the bus cable power). In this configuration,
power must be supplied on the V+ and V– pins on the port connector.

Connecting pins 2 and 3 of a jumper configures the CAN physical laye
be powered internally (from the board). In this configuration, the V– sign
serves as the reference ground for the isolated signals.

Figure B-4 shows how to configure your jumpers for internal or externa
power supplies.

Figure B-4.  Power Source Jumpers

1 Power Supply Jumper J6
4 Power Supply Jumper J5

3 Assembly Number
4 Product Name

5 Serial Number

3

5

2

1

4

INT EXT

a. Internal Power Mode

INT EXT

b. External Power Mode

123 123
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The CAN physical layer is still isolated regardless of the power source
chosen.

Bus Power Supply Requirements
If the CAN physical layer is powered from a bus power supply, the pow
supply should be a DC power supply with an output of 10 V to 30 V. T
power requirements for the CAN ports for bus-powered configurations 
shown in Table B-1. You should take these requirements into account w
determining requirements of the bus power supply for the system.

Cable Specifications
Cables should meet the physical medium requirements specified in 
ISO 11898, shown in Table B-2.

Belden cable (3084A) meets all of those requirements, and should be
suitable for most applications.

Table B-1.  Power Requirements for the CAN Physical Layer for 
Bus-Powered Versions

Characteristic Specification

Voltage Requirement V+ 10 to 30 VDC

Current Requirement 40 mA typical 
100 mA maximum

Table B-2.  ISO 11898 Specifications for Characteristics of a CAN_H and 
CAN_L Pair of Wires

Characteristic Value

Impedance 108 Ω minimum, 120 Ω nominal, 
132 Ω maximum

Length-related resistance 70 mΩ/m nominal

Specific line delay 5 ns/m nominal
PXI-8461 and NI-CAN for Windows 95/98 B-4 © National Instruments Corporation
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Cable Lengths
The allowable cable length is affected by the characteristics of the 
cabling and the desired bit transmission rates. Detailed cable length 
requirements can be found in ISO 11898, CiA Draft Standard 102, and
DeviceNet Specification.

ISO 11898 specifies 40 m total cable length with a maximum stub leng
of 0.3 m for a bit rate of 1 Mb/s. The ISO 11898 specification says tha
significantly longer cable lengths may be allowed at lower bit rates, bu
each node should be analyzed for signal integrity problems.

Table B-3 lists the DeviceNet cable length specifications.

Maximum Number of Devices
The maximum number of devices that you can connect to a CAN port 
depends on the electrical characteristics of the devices on the network.
of the devices meet the requirements of ISO 11898, at least 30 devices
be connected to the bus. Higher numbers of devices may be connected
electrical characteristics of the devices do not degrade signal quality be
ISO 11898 signal level specifications. If all of the devices on the netwo
meet the DeviceNet specifications, 64 devices may be connected to th
network.

Table B-3.  DeviceNet Cable Length Specifications

Baud Rate Trunk Length
Drop Length 
Maximum

Drop Length 
Cumulative

500 kb/s 100 m (328 ft) 6 m (20 ft) 39 m (128 ft)

250 kb/s 250 m (820 ft) 6 m (20 ft) 78 m (256 ft)

125 kb/s 500 m (1640 ft) 6 m (20 ft) 156 m (512 ft)
© National Instruments Corporation B-5 PXI-8461 and NI-CAN for Windows 95/98
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Cable Termination
The pair of signal wires (CAN_H and CAN_L) constitutes a transmissi
line. If the transmission line is not terminated, each signal change on t
line causes reflections that may cause communication failures.

Because communication flows both ways on the CAN bus, CAN requi
that both ends of the cable be terminated. However, this requirement d
not mean that every device should have a termination resistor. If multi
devices are placed along the cable, only the devices on the ends of the
should have termination resistors. See Figure B-5 for an example of wh
termination resistors should be placed in a system with more than two
devices.

Figure B-5.  Termination Resistor Placement

The termination resistors on a cable should match the nominal impeda
of the cable. ISO 11898 requires a cable with a nominal impedance of
120Ω; therefore, a 120 Ω resistor should be used at each end of the cab
Each termination resistor should each be capable of dissipating at lea
0.25 W of power.

120 Ω 120 Ω

CAN_H

CAN_L
CAN

Device

CAN
Device

CAN
Device

CAN
Device
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Cabling Example
Figure B-6 shows an example of a cable to connect two CAN devices.
the internal power configuration, no V+ connection is required.

Figure B-6.  Cabling Example

9-Pin
D-Sub

9-Pin
D-Sub

CAN_H

CAN_L

Shield

V+

V+

V–

V–

5-Pin
Combicon

5-Pin
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Pin 7Pin 4 Pin 7 Pin 4

Pin 2 Pin 2

Pin 5 Pin 3

Pin 9 Pin 5

Pin 3 Pin 1

Pin 2Pin 2

Pin 5Pin 3

Pin 9Pin 5

Pin 3Pin 1

120Ω 120Ω

Power
Connector
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Common Questions

This appendix describes how to troubleshoot problems and answers som
common questions.

Device Manager Problems
The Windows Device Manager contains configuration information for all 
of the hardware in your system. To start the Windows Device Manager, 
double-click on the System icon under Start»Settings»Control Panel. In 
the System Properties box that appears, select the Device Manager tab 
and click on the View devices by type radio button at the top of the tab. 

If there is no National Instruments CAN Interfaces item and you are 
certain your board is installed, refer to the No National Instruments CAN 
Interfaces section of this appendix. This problem occurs when 
Windows 95/98 does not display the New Hardware Found dialog box 
when expected.

If the National Instruments CAN Interfaces item exists, but the board 
you are looking for is not listed there, refer to the Missing Board in Device 
Manager section of this appendix.

If the board you are looking for is listed, but has a circled X or exclamation 
mark (!) over its icon, refer to the Problem Shown in Device Manager 
section of this appendix.

No National Instruments CAN Interfaces
If you are certain your board is installed, but no National Instruments 
CAN Interfaces item appears in the Device Manager, the board is 
probably incorrectly listed under Other Devices. This problem occurs 
when Windows 95/98 does not display the New Hardware Found dialog 
box when expected.
r Windows 95/98
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To fix the problem, complete the following steps:

1. Select Start»Settings»Control Panel.

2. Double-click on the System icon to display the System Properties 
dialog box for the computer.

3. Click on the Device Manager tab at the top of the System Properties 
sheet to bring up the Device Manager property page. Make sure the 
View devices by type button at the top of the Device Manager page 
is selected.

4. Click on the plus sign next to Other Devices to display a list of all the 
hardware devices that Windows has detected and configured as Other 
Devices. 

5. For each PXI-8461 listed, select the board by clicking on it, and th
click on the Remove button to remove each board from the list of 
Other Devices.

6. After you have removed all of the PXI-8461 boards from the list of
Other Devices, click on the Refresh button to force Windows to detect
each PXI-8461 and to display a New Hardware Found dialog box for 
each one. Your PXI-8461 boards should now appear under National 
Instruments CAN Interfaces.

7. Verify the installation, as described in Chapter 3, Verify the 
Installation.

Missing Board in Device Manager
If the National Instruments CAN Interfaces item exists, but the board 
you are looking for is not listed there, the board is not properly installe
This problem indicates that the board is not physically present in the 
system. Make certain that the board is fully inserted.

Problem Shown in Device Manager
If a PXI-8461 is not working properly, its icon has a circled X or 
exclamation mark (!) overlaid on it, as shown in Figure C-1. 
PXI-8461 and NI-CAN for Windows 95/98 C-2 © National Instruments Corporation
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Figure C-1.  Device Manager Shows PXI-8461 That Is Not Working Properly

This problem can occur for several reasons. If you encounter this prob
the Device Manager should list an error code that indicates why the 
problem occurred. To see the error code for a particular interface, selec
name of the interface and click on the Properties button to go to the 
General tab for that interface. The Device Status section of the General 
tab shows the error code. Locate the error code in the following list to f
out why your interface is not working properly.

Code 8: The NI-CAN software was incompletely installed. To solv
this problem, reinstall the NI-CAN software.

Code 9: Windows had a problem reading information from the 
interface. Contact National Instruments for assistance.

Code 12: Your interface was not assigned a physical memory rang
If your computer does not have 8 KB of available memory
Windows might configure your interface without a physica
memory assignment. The NI-CAN software cannot functio
without 8 KB of physical memory. Another way to verify this
© National Instruments Corporation C-3 PXI-8461 and NI-CAN for Windows 95/98
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problem is to look at the Resource settings list on the 
Resources tab to verify that the interface was not assigned
Memory Range. To solve this problem, free up an 8 KB 
Memory Range (such as D0000 to D1FFF hex) that is being 
used by another device in the system.

Code 15: Your interface was not assigned an Interrupt Request leve
your computer does not have any available Interrupt Requ
levels, Windows might configure your interface without an
Interrupt Request level. The NI-CAN software cannot 
function without an Interrupt Request level. Another way t
verify this problem is to look at the Resource settings list on 
the Resources tab to verify that your interface was not 
assigned an Interrupt Request level. To solve this problem
free up an Interrupt Request level that is being used by 
another device in the system.

Code 22: Your interface is disabled. To enable your interface, check
appropriate configuration checkbox in the Device Usage 
section of the General tab.

Code 24: Your interface is not present, or the Device Manager is 
unaware that your interface is present. To solve this proble
select your interface in the Device Manager, and click on t
Remove button. Next, click on the Refresh button. At this 
point, the system rescans the installed hardware, and you
interface should appear. If the problem persists, contact 
National Instruments.

Code 27: Windows was unable to assign your interface any resour
To solve this problem, free up system resources by disabl
other unnecessary hardware so that enough resources ar
available for your interface. The resources required for a 
single interface are an Interrupt Request level and an 8 K
physical memory range (such as D0000 to D1FFF hex).

Diagnostic Utility Failures
The following sections explain common error messages generated by
NI-CAN Diagnostic utility.
PXI-8461 and NI-CAN for Windows 95/98 C-4 © National Instruments Corporation
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Memory Resource Conflict
This error occurs if the memory resources assigned to a board conflict 
the memory resources being used by other hardware in the system. 
Resource conflicts typically occur when your system contains legacy 
hardware that uses resources that have not been reserved properly wi
Device Manager. If a resource conflict exists, write down the memory 
resource that caused the conflict and refer to the Microsoft Windows 95
User’s Guide for instructions on how to use the Device Manager to rese
memory resources for legacy hardware. After the conflict has been 
resolved, run the NI-CAN Diagnostic utility again.

Interrupt Resource Conflict
This error occurs if the interrupt resources assigned to a board conflict 
the interrupt resources being used by other hardware in the system. 
Resource conflicts typically occur when your system contains legacy 
hardware that use resources that have not been reserved properly wit
Device Manager. If a resource conflict exists, write down the interrupt 
resource that caused the conflict and refer to the Microsoft Windows 95
User’s Guide for instructions on how to use the Device Manager to rese
interrupt resources for legacy boards. After the conflict has been resol
run the NI-CAN Diagnostic utility again.

NI-CAN Software Problem Encountered
This error occurs if the NI-CAN Diagnostic utility detects that it is unab
to communicate correctly with the hardware using the installed NI-CAN
software. If you get this error, shut down your computer, restart it, and 
the NI-CAN Diagnostic utility again. If the problem persists, try 
reinstalling the NI-CAN software. 

Missing Board in Diagnostic Utility
If a board is physically installed in your system, but is not listed in the 
NI-CAN Diagnostic utility, check the Windows Device Manager to see 
Windows has detected the board. For more information, refer to the Device 
Manager Problems section, earlier in this appendix.

Hardware Problem Encountered
This error occurs if the NI-CAN Diagnostic utility detects a defect in th
hardware. If you get this error, write down the numeric code shown with
error and contact National Instruments. Depending on the cause of the
hardware failure, you may need to repair or replace your board.
© National Instruments Corporation C-5 PXI-8461 and NI-CAN for Windows 95/98
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Common Questions
How can I determine which board I have installed?

Run the NI-CAN Configuration utility. To run the utility, select 
Start»Settings»Control Panel»System. Select the Device Manager tab 
in the System Properties dialog box. Click on the View devices by type 
radio button at the top of the sheet. If a PXI-8461 is correctly installed,
National Instruments CAN Interfaces icon appears in the list of device 
types. Double-click this icon to see a list of installed hardware.

How can I determine which version of the NI-CAN software I have 
installed?

Run the NI-CAN Diagnostic utility. To run the utility, select the Diagnostic 
item under Start»Programs»NI-CAN Software. The NI-CAN Diagnostic 
utility displays information about the version of the NI-CAN software 
currently installed.

Which CAN interfaces does the NI-CAN software for Windows 95/98 
support?

The NI-CAN software for Windows 95/98 supports the AT-CAN, 
AT-CAN/2, PCI-CAN, PCI-CAN/2, PCMCIA-CAN, PCMCIA-CAN/2, 
and PXI-8461 (one port or two port).

How many PXI-8461 boards can I configure for use with my NI-CAN 
software for Windows 95/98? 

The NI-CAN software for Windows 95/98 can be configured to 
communicate with up to 10 boards. 

Are interrupts required for the PXI-8461?

Yes, one interrupt per board is required.

What do I do if my board is listed in the Windows Device Manager with 
a circled X or exclamation point (!) overlaid on it?

Refer to the Problem Shown in Device Manager section of this appendix 
for specific information about what might cause this problem. If you ha
already completed the troubleshooting steps, fill out the forms in 
Appendix E, Customer Communication, and contact National Instruments 
PXI-8461 and NI-CAN for Windows 95/98 C-6 © National Instruments Corporation
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What do I do if the NI-CAN Diagnostic utility fails with an error?

Refer to the Diagnostic Utility Failures section of this appendix for specific
information about what might cause the NI-CAN Diagnostic utility to fa
If you have already completed the troubleshooting steps, fill out the for
in Appendix E, Customer Communication, and contact National 
Instruments.

How do I use an NI-CAN language interface?

For information about using NI-CAN language interfaces, refer to 
Chapter 3, Developing Your Application, in the NI-CAN User Manual.

How do I use NI-CAN from within LabVIEW or BridgeVIEW?

For information about using NI-CAN from within LabVIEW, refer to 
Chapter 3, Developing Your Application, in the NI-CAN User Manual.

Why does the uninstall program leave some components installed?

The uninstall program removes only items that the installation program
installed. If you add anything to a directory that was created by the 
installation program, the uninstall program does not delete that directo
because the directory is not empty after the uninstallation. You must 
remove any remaining components yourself.

What information should I have before I call National Instruments?

When you call National Instruments, you should have all of the informat
filled out on the Hardware and Software Configuration Form in 
Appendix E, Customer Communication.
© National Instruments Corporation C-7 PXI-8461 and NI-CAN for Windows 95/98
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Specifications

This appendix describes the physical characteristics of the hardware a
the recommended operating conditions.

Table D-1.  PXI-8461 One Port and Two Port Hardware Characteristics

Characteristic Specification

Dimensions PXI 3U Module
100 by 160 mm
(3.94 by 6.30 in.)

Power Requirement +5 VDC 500 mA typical

I/O Connector 9-pin D-Sub for each port (standard)
or
5-pin Combicon-style pluggable 
DeviceNet screw terminal

Operating Environment
Component Temperature
Relative Humidity

0° to 55° C
10% to 90%, noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
10% to 90%, noncondensing

Table D-2.  CAN Port Characteristics for Bus-Powered Ports

Characteristic Specification

Power Requirement 10 to 30 V 40 mA typical
100 mA maximum

Isolation 500 VDC optical
r Windows 95/98
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Customer Communication

For your convenience, this appendix contains forms to help you gather the information necessa
to help us solve your technical problems and a form you can use to comment on the product 
documentation. When you contact us, we need the information on the Technical Support Form
the configuration form, if your manual contains one, about your system configuration to answer
questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to
provide the information you need. Our electronic services include a bulletin board service, an FT
a fax-on-demand system, and e-mail support. If you have a hardware or software problem, first 
electronic support systems. If the information available on these systems does not answer you
questions, we offer fax and telephone support through our technical support centers, which are
by applications engineers. 

Electronic Services

Bulletin Board Support
National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of
and documents to answer most common customer questions. From these sites, you can also d
the latest instrument drivers, updates, and example programs. For recorded instructions on how
the bulletin board and FTP services and for BBS automated information, call 512 795 6990. Yo
access these services at:

United States: 512 794 5422
Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom:  01635 551422
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France:  01 48 65 15 59
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support
To access our FTP site, log on to our Internet host, ftp.natinst.com , as anonymous  and use 
your Internet address, such as joesmith@anywhere.com , as your password. The support files and
documents are located in the /support  directories.
r Windows 95/98
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Fax-on-Demand Support
Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a
range of technical information. You can access Fax-on-Demand from a touch-tone telephone a
512 418 1111.

E-Mail Support (Currently USA Only)
You can submit technical support questions to the applications engineering team through e-mai
Internet address listed below. Remember to include your name, address, and phone number so
contact you with solutions and suggestions. 

support@natinst.com

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technic
support number for your country. If there is no National Instruments office in your country, cont
the source from which you purchased your software to obtain support.

Country Telephone Fax
Australia 03 9879 5166 03 9879 6277
Austria 0662 45 79 90 0 0662 45 79 90 19
Belgium 02 757 00 20 02 757 03 11
Brazil 011 288 3336 011 288 8528
Canada (Ontario) 905 785 0085 905 785 0086
Canada (Quebec) 514 694 8521 514 694 4399
Denmark 45 76 26 00 45 76 26 02
Finland 09 725 725 11 09 725 725 55
France 01 48 14 24 24 01 48 14 24 14
Germany 089 741 31 30 089 714 60 35
Hong Kong 2645 3186 2686 8505
Israel 03 6120092 03 6120095
Italy 02 413091 02 41309215
Japan 03 5472 2970 03 5472 2977
Korea 02 596 7456 02 596 7455
Mexico 5 520 2635 5 520 3282
Netherlands 0348 433466 0348 430673
Norway 32 84 84 00 32 84 86 00
Singapore 2265886 2265887
Spain 91 640 0085 91 640 0533
Sweden 08 730 49 70 08 730 43 70
Switzerland 056 200 51 51 056 200 51 55
Taiwan 02 377 1200 02 737 4644
United Kingdom 01635 523545 01635 523154
United States 512 795 8248 512 794 5678
PXI-8461 and NI-CAN for Windows 95/98 E-2 © National Instruments Corporation
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Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, a
the completed copy of this form as a reference for your current configuration. Completing this f
accurately before contacting National Instruments for technical support helps our applications 
engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem
include the configuration forms from their user manuals. Include additional pages if necessary.

Name ______________________________________________________________________

Company ___________________________________________________________________

Address ____________________________________________________________________

___________________________________________________________________________

Fax ( ___ ) ________________Phone ( ___ ) ______________________________________

Computer brand____________ Model ___________________Processor _____________________

Operating system (include version number) ________________________________________

Clock speed ______MHz   RAM _____MB Display adapter ________________________

Mouse ___yes   ___no     Other adapters installed___________________________________

Hard disk capacity _____MB Brand______________________________________________

Instruments used _____________________________________________________________

___________________________________________________________________________

National Instruments hardware product model _____________ Revision  ____________________

Configuration _______________________________________________________________

National Instruments software product ___________________ Version  _____________________

Configuration _______________________________________________________________

The problem is: ______________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

List any error messages: _______________________________________________________

___________________________________________________________________________

___________________________________________________________________________

The following steps reproduce the problem: _______________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________
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Hardware and Software Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of each
Complete a new copy of this form each time you revise your software or hardware configuration
use this form as a reference for your current configuration. Completing this form accurately bef
contacting National Instruments for technical support helps our applications engineers answer 
questions more efficiently.

National Instruments Products
General Information

CAN Interface Type (such as PXI-8461) ___________________________________________

NI-CAN Diagnostic Utility Results ________________________________________________

Version Information
To access complete version information, including the hardware version and the NI-CAN 
driver version, open the MS-DOS Prompt and change to the NI-CAN installation directory 
(usuallyc:\nican ). At the prompt, enter the following command:

candiag -v

Version Information from the NI-CAN Diagnostic ____________________________________

___________________________________________________________________________

Other Products
Resource Summary Report from the Device Manager
To create this report, first display the System Properties dialog box for the computer by 
double-clicking on the System icon under Start»Settings»Control Panel. Then click on the 
Device Manager tab and highlight the Computer icon. Click on the Print  button, and check the 
Print to File  checkbox in the Print  dialog box before clicking on OK .

Programming Environment Information

Programming Language _______________________________________________________

Compiler Vendor_____________________________________________________________

Compiler Version _____________________________________________________________

Application Information

LabVIEW Application _________________________________________________________

Win32 Application ____________________________________________________________

If Win 32, method of accessing DLL (link with language interface or direct entry?) __________

___________________________________________________________________________
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Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our pro
This information helps us provide quality products to meet your needs.

Title: Getting Started with Your PXI-8461 and the NI-CAN™ Software for Windows 95/98

Edition Date: May 1998

Part Number: 322005A-01

Please comment on the completeness, clarity, and organization of the manual.

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

Thank you for your help.

Name _____________________________________________________________________

Title ______________________________________________________________________

Company ___________________________________________________________________

Address ____________________________________________________________________

___________________________________________________________________________

E-Mail Address ______________________________________________________________

Phone ( ___ ) __________________________  Fax ( ___ ) ___________________________

Mail to: Technical Publications Fax to: Technical Publications
National Instruments Corporation National Instruments Corporation
6504 Bridge Point Parkway 512 794 5678
Austin, Texas 78730-5039



Glossary
Prefix Meanings Value

n- nano- 10–9

m- milli- 10–3

k- kilo- 103

M- mega- 106

° degrees

Ω ohms

% percent

A amperes

AC alternating current

ANSI American National Standards Institute

AT-compatible compatible with the 16-bit Industry Standard Architecture

b bits

C Celsius

CAN Controller Area Network

CiA CAN in Automation

DC direct current

DLL dynamic link library

DMA direct memory access

EMI electromagnetic interference

FCC Federal Communications Commission

ft feet

hex hexadecimal

HMI Human Machine Interface
© National Instruments Corporation G-1 PXI-8461 and NI-CAN for Windows 95/98



Glossary

ding 
uch 
Hz hertz

IEEE Institute of Electrical and Electronic Engineers

in. inches

I/O input/output

IRQ interrupt request

ISA Industry Standard Architecture

ISO International Standards Organization

KB kilobytes of memory

m meters

MB megabytes of memory

PC personal computer

PCI peripheral component interconnect

PCMCIA Personal Computer Memory Card International Association

PLC Programmable Logic Controller

RAM random-access memory

resource hardware settings used by National Instruments CAN hardware, inclu
an interrupt request level (IRQ) and an 8 KB physical memory range (s
as D0000 to D1FFF hex)

s seconds

V volts

VDC volts direct current

VXI VME eXtensions for Instrumentation

W watts
PXI-8461 and NI-CAN for Windows 95/98 G-2 © National Instruments Corporation
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